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1   Aufgabenstellung 
 
 
Das vorliegende Beispiel vermittelt eine Einführung in die Methodik und Arbeitsweise 
der quantitativen Analyse mittels HPLC. Die in einer ausgegebenen Probe 
enthaltenen drei Lebensmittelfarbstoffe werden zuerst über Retentionszeitvergleich 
mit Standardlösungen identifiziert und anschließend quantitativ bestimmt. 
 
 

In der Probe sind folgende Farbstoffe enthalten: 
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Charakteristika:

- Lebensmittelfarbstoffe

- wasserlöslich

 
 
Diese Substanzen zählen zur Gruppe der Azofarbstoffe und sind sehr weit verbreitete  

hydrophile Lebensmittelfarbstoffe. 
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Arbeitsschema 
 
 
 
 
 
 
 
        

Inbetriebnahme des HPLC Systems 
Äquilibrierung der Trennsäule 

Analyse der Einzelstandards und der Probe 

Herstellung  und Analyse der Multikomponentenstandards 

Erstellung der Eichfunktion und quantitative Auswertung der 
Probenchromatogramme 

Reinigung der Trennsäule 

Ausschalten der Geräte 
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2   Beschreibung des chromatographischen Systems 

 
 
Das verwendete HPLC-System besteht aus einer Gradientenpumpe mit den 
entsprechenden Eluentenvorratsgefäßen, einem Dosiersystem für die Einbringung 
der Probe in das Trennsystem, einer Trennsäule sowie einem variablen 
Wellenlängendetektor. 
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Die Steuerung des HPLC-System erfolgt vom PC aus mit der 
Chromatographiesoftware EZChrom elite. 
 
 
Details des chromatographischen Systems: 
 
Eluent Kanal A: Mobile Phase (Zusammensetzung siehe unten) 
 

Eluent Kanal B,C,D: Methanol 
 

Fließgeschwindigkeit: 1.0 mL/min 
 

Dosierschleifenvolumen: 20 µL 
 

Trennsäule: Spherisorb ODS (RP 18), 150 x 4 mm I.D., 5 µm Partikelgröße 
 

Det.-Wellenlänge: 250 nm 
 
Zusammensetzung mobile Phase (Kanal A) 
 

– 450 mL Methanol (HPLC grade) 
 

– 100 mL Britton-Robinson-Puffer 
(3 ml ortho-Phosphorsäure + 3 ml Eisessig + 3 g Borsäure auf 1 L bidestilliertes Wasser) 

 

– 50 mL 0.1 M Tetrabutylammoniumhydrogensulfat 
 

– 400 mL bidestilliertes Wasser 
 

– Mischung mit 2 M Natronlauge auf pH = 6.2 einstellen (mit Glaselektrode, die 
zuvor kalibriert wurde) 
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3   Erste Schritte 
 
 

3.1. Inbetriebnahme  
 

Zuerst werden Monitor und Computer eingeschaltet. Falls erforderlich wird unter 
„Praktikum“ eingeloggt (kein Passwort erforderlich). Erst nach  dem vollständigen 
Laden des Betriebssystems werden Pumpe und Detektor eingeschaltet. Keinesfalls 
früher!  Danach wird  das Programm EZStart aufgerufen. 
 
 

3.2. Erstellung eines persönlichen Methodenfiles 
 

Im Rahmen des Praktikums verwendet jede/r StudentIn sein/ihr persönliches 
Methodenfile, welches im weiteren Verlauf mit individuellen Kalibrationsfaktoren 
modifiziert wird. Unter  File → Method → open  öffnet sich ein Fenster zur Auswahl 
der Methode. Es wird die Methode „ACUE“ verwendet. Über  File → Method → 
Save as...  wird das File unter „ACUE-Name“ abgespeichert („Name“ = Eingabe des 
eigenen Namens). Diese Methodenfile wird ab nun für die Datenaufnahme und 
Datenauswertung verwendet. 
 
 
 

4   Vorbereitung des chromatographischen Trennsystem 
 
 

4.1. Spülen der Pumpe 
 
Zur Entfernung von Luftblasen aus den Eluentenleitungen wird das Drain-Ventil der 
Pumpe (befindet sich vorne in der Mitte der Gradientenpumpe) durch eine halbe 
Umdrehung nach links geöffnet. Über  Control → Instrument Status  wird die Seite 
„Pump“ ausgewählt. 
 

 
 
Auf dieser Seite wird die Schaltfläche „Turn on“ angeklickt und kurze Zeit später die 
Schaltfläche „Purge“. 
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Es öffnet sich daraufhin folgendes Fenster: 
 

 
 
Nachfolgend wird Kanal A in „Solvent select“ ausgewählt, mit „Purge on“ aktiviert 
und für die Dauer von 0,5 – 1 min aktiv gehalten. Am Ende wird auf 100 % A gestellt. 
Mit „Purge off“ und „close“ wird der Vorgang beendet. Das Drain-Ventil wird durch 
eine halbe Umdrehung nach rechts geschlossen. 
 
 
4.2. Äquilibrieren der Trennsäule 
 
Auf der Seite „Pump“ wird die Funktion „Manual Set“ aktiviert und die Parameter 
wie abgebildet eingestellt:  
Druck 250 bar, Fließgeschwindigkeit 1,0 mL/min, 100 % A. 
(Hinweis: %A + %B + %C +%D = 100 %. A  wird deshalb über B,C und D 
eingestellt.) 
 

 
 
Nach Eingabe wird das Fenster mit „ok“ geschlossen. 
 
 
Die Trennsäule wird 20 – 30 Minuten lang äquilibriert. Danach werden  die Probe 
bzw. die Einzelstandards dosiert. In der Zwischenzeit werden die Standardlösungen 
hergestellt. 
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5   Herstellung der Standardlösungen 
 
 

 Es werden Stammlösungen mit einer Konzentration von 1 mg/mL von jeder 
Komponente verwendet. Diese Stammlösungen werden in der Regel vom 
Assistenten zur Verfügung gestellt. Sollte dies nicht der Fall sein, müssen sie 
hergestellt werden, in dem die entsprechende Menge des jeweiligen Farbstoffes 
auf der Analysenwaage eingewogen und in einem Messkolben bis zur 
entsprechenden Marke mit destilliertem Wasser verdünnt wird. 

 

 Es sind Einzelstandards der Konzentration 100 µg/mL herzustellen. Diese 
werden für die qualitative Analyse benötigt (Peakzuordnung). 

 

 Verdünnungsreihe für quantitative Analyse: Es werden fünf Konzentrationen 
mit allen drei Analyten (= Multikomponenten-Standards) in jeweils einem 
Messkolben hergestellt. 

 

Kalibrationsbereich: für jede Komponente 5 – 100 µg/mL 
 

…wobei folgende Konzentrationsstufen empfohlen werden: 
 

5 - 10 - 25 - 50 - 100 µg/mL 
 
 
 

6   Analyse der Proben und Standardlösungen 
 
 

6.1. Vorbereitung des Datensystems 
 

Der folgende Vorgang gilt allgemein für die Aufnahme von Chromatogrammen. 
 

Über  Control → Single Run  öffnet sich folgendes Fenster: 
 

 
 

In dem geöffneten Fenster wird unter „Sample ID“ eine Beschreibung der Probe 
abgelegt (zB Probe-Name, STD 1:100 usw.). Unter „Data File“ wird der Dateiname 
eingegeben. Eine Verknüpfung mit dem eigenen Namen erscheint im Rahmen des 
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Praktikums sinnvoll (z.B. Name1, Name2,....  Name-STD1, Name-STD2...). Die 
Funktionen „Print Method Report“ und „Calibrate“ sind deaktiviert. 
 

Danach wird „Start“ angeklickt. Die Datenaufnahme startet hierbei allerdings noch 
nicht, sondern erst nach Dosierung der Probe (siehe unten). Wenn am unteren Rand 
des Fensters die Nachricht „Waiting for Trigger“ erscheint, kann mit der Dosierung 
der Probe bzw. Standards begonnen werden.  
Der Schalthahn des Dosiersystems wird von der Stellung „Inject“ in die Stellung 
„Load“ gedreht. Ein zügiges Umschalten ist notwendig, da zwischen den beiden 
Positionen keine Eluentenförderung möglich ist (führt zu Druckanstieg was bei 250 
bar zu einem automatischen Stopp der Pumpe führt). 
 
 
 
6.2. Dosierung von Probe und Standard 
 

Die ausgegebene Probe wird mindestens dreimal analysiert, die einzelnen 
Standardlösungen mindestens einmal (beginnend mit den Einzelstandards). 
 

Die Dosierspritze sollte nach jeder Dosierung mit einem Methanol-Wasser Gemisch 
(Mischverhältnis ca. 50:50) gespült werden und vor jeder Injektion mit der jeweils zu 
injizierenden Lösung (um Verdünnungsfehler zu minimieren). Bei Standardlösungen 
sollte überdies mit der Lösung geringster Konzentration begonnen werden. 
 

In die Dosierspritze werden ca. 80 – 100 µL Probe- oder Standardlösung aufgezogen 
(ohne Luftblasen) und in das Dosiersystem eingeführt. Das gesamte Volumen wird 
dosiert (ohne Luftblasen). Danach wird die Dosierspritze wieder herausgezogen 
und der Schalthahn in die Position "Inject" gedreht (wiederum zügig). 
Dadurch gelangt die Probelösung auf die Trennsäule und die Datenaufnahme wird 
gleichzeitig automatisch gestartet. 
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7   Datenauswertung 
 
 
 
 
Die Datenaufnahme erfolgt mit dem Programm EZStart, die Erstellung der 
Eichfunktionen und  Auswertung der Chromatogramme wird mit dem Programm 
EZStart offline durchgeführt. 
 
Nach dem Aufruf des Programms  EZStart offline wird das zuvor erstellte 
persönliche Methodenfile über File → Method  → open geladen. 
 
 

7.1. Kalibrierung des chromatographischen Systems und quantitative 
Analyse 
 
Bevor eine quantitative Auswertung der Probe durchgeführt werden kann, muss die 
Kalibrationsfunktion für jede zu bestimmende Substanz erstellt werden. Dazu wird 
zuerst über  Method → Peaks/Groups  die Peaktabelle für die Methode geöffnet. 
 

 
 
 
Auf der Seite „Named Peaks“ werden für jede zu bestimmende Substanz folgende 
Parameter eingegeben: 
 

Name: Name der Verbindung 
Auf Basis der Einzelstandard-Injektionen können die einzelnen Peaks zugeordnet 
werden. 
Ret. Time: Retentionszeit der jeweiligen Verbindung (im Peakmaximum). 
Window: Hier wird das maximale Ausmaß von  Retentionszeitschwankungen 
angegeben (10% voreingestellt). Die Peaks der Analyten müssen innerhalb dieses 
Retentionszeitfensters liegen, um richtig erkannt zu werden. Das 
Retentionszeitfenster wird von der eingegeben Retentionszeit automatisch berechnet 
(durch Anklicken des Eingabefensters). 
 

Units: Konzentrationseinheiten der Eichstandardlösungen (meist  µg/mL bzw.  
mg/L). 
 

Quantitate: Quantifizierung erfolgt durch Auswertung des Peakflächenintegrals (→ 
Area) oder der Peakhöhe (→ Height) 
 

Fit Type: In vorliegendem Beispiel sind lineare Kalibrationsfunktionen zu erwarten. 
 

Calib Flag: Bei Replace werden bei einer Neuauswertung der 
Standardchromatogramme  die neuen Kalibrationsfaktoren übernommen. 
 

Bei Average erfolgt eine Mittelung der Kalibrationsfaktoren. 
 

Bei Vorliegen von mehreren Standardchromatogrammen gleicher Konzentrationen  
sollte Average gewählt werden, sonst Replace. 
 

Level 1...10: Hier sind die Konzentrationen der einzelnen Standardlösungen 
einzusetzen (bezogen auf die Dimension  in der Spalte Units).  
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Anschließend werden die Kalibrationsfaktoren berechnet. Dazu werden 
nacheinander über  Analysis → Analysis/Singel Level Calibration  die 
Standardchromatogramme aufgerufen. 
 
Es erscheint folgendes Fenster: 
 

 
 
Unter  „Data file“  wird der Filename des Standardchromatogramms eingegeben. 
Die Funktion  „Calibrate“  wird aktiviert und unter  „Calibration level“  wird die 
Zuordnung des Files zu den Konzentrationsangaben  in der Peaktabelle (Level 
1....10) hergestellt. Alle anderen Funktionen bleiben deaktiviert. Durch Anklicken von 
„Start“ wird der Auswertevorgang gestartet. Dieser Vorgang wird für alle 
Standardkonzentrationen durchgeführt. 
 
Nach Auswertung des letzten Standardchromatogramms wird unter  Method → 
Review → Calibration  eine graphische Darstellung der  Eichfunktion aufgerufen. 
 
Es erscheint folgendes Fenster: 
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Die Kalibrationsfunktionen der einzelnen Substanzen werden auf ihre Linearität und 
Korrelation überprüft (Auswahl im oberen rechten Feld des Fensters). Für jede zu 
bestimmende Substanz wird danach folgender Vorgang durchlaufen: 
 

Durch Anklicken von einem der rechten weißen Felder mit der rechten Maustaste 
öffnet sich folgendes Kontextmenu: 
 

 
 

 
 
Durch Anklicken von „Print All Peaks/ Groups“ werden die Eichfunktionen sowie alle 
Eichdaten und statistischen Berechnungen ausgedruckt. 
 
 

7.2. Auswertung der Probenchromatogramme 
 
Über  File → Data → open  wird das gewünschte Datenfile geöffnet. Eine 
Peakerkennung bzw. Peakauswertung wird über  Analysis → Analyze  initiiert. Im 
Chromatogramm-Fenster wird daraufhin das Chromatogramm  mit der berechneten 
Basislinie  bzw. den Markern für Peakanfang und Peakende  dargestellt.  
 

Eine Vorschau der Auswertung  ist über  „Reports → View → External Standard“  
möglich. Über Reports →  Print → External Standard  wird der quantitative 
Analysenreport ausgedruckt. 
Es ist aber auch hier ist die korrekte Peakerkennung  bzw.  Peakintegration zu 
überprüfen ! Bei nicht korrekten Integrationsgrenzen kann  manuell integriert werden.  
 
 
Manuelle Integration:  

Aus der Taskleiste am unteren Bildschirmrand wird Manual Baseline  (  ) 
angeklickt. 
Der Cursor wird an den Peakanfang positioniert und die linke Maustaste wird 
gedrückt. Danach wird der Cursor an das Peakende  positioniert und wiederum wird 
die linke Maustaste gedrückt.  Im darauf erscheinenden Fenster wird die Schalfläche 
„Analyze now“ angeklickt. Nach dieser Neuauswertung kann der Analysenreport 
über  Reports →  Print → External Standard   ausgedruckt werden. 
 
Aus den Analysenergebnissen können nun Mittelwert, Standardabweichung und 
Vertrauensbereich berechnet werden.  
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8   Beendigung der Arbeit 
 
 

8.1. Spülen der Trennsäule 
 
Am Ende der praktischen Arbeiten des jeweiligen Arbeitstages wird die Trennsäule 
gereinigt. Dazu wird über  Control → Instrument Status  auf der Seite „Pump“ 
über „Manual Set“ der Eluent auf 100 % B (Methanol) gestellt (Fließgeschwindigkeit 
1.0 mL/min). Die Trennsäule wird unter diesen Bedingungen 15 min gespült.  
Danach wird die Pumpe gestoppt (→ Turn off). 
 
 

8.2. Ausschalten der Geräte 
 
Nach Beendigung aller Arbeiten wird der Computer heruntergefahren und Pumpe, 
Detektor sowie Monitor werden ausgeschaltet. 
 
 



13 

 

9   Protokoll 
 
 
Im Protokoll, welches handschriftlich anzufertigen ist, müssen folgende Punkte 
enthalten sein: 
 

 Aufgabenstellung 
 

 Versuchsaufbau und -durchführung 
 

 Beschreibung des chromatographischen Systems (Trennprinzip, 
chromatographische Parameter wie Eluent, Trennsäule, Detektion etc.). 

 

 Herstellung und Konzentrationsangaben der Standardlösungen 
 

 Graphische Darstellung der Kalibrationsfunktion inklusive Geradengleichung 
und Korrelationkoeffizienten (Bestimmtheitsmaß) (EZ Chrom Ausdruck oder 
Excel-Diagramm) 

 

 Tabellarische Darstellung der einzelnen Analysenresultate (Standard, Probe, 
Fläche oder Höhe) und Statistik (Mittelwert, Standardabweichung und 
Vertrauensintervall der berechneten Konzentrationen) 

 

 Exemplarisch wird ein Chromatogramm der ausgegebenen Probe eingeklebt 
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ANHANG 
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Standardform der Angabe von Analysenresultaten 
 

x
t P f s

n
n s P

,
, ,    Dimension  

 
 

Mittelwert Vertrauensbereich VBx  
 
n…….Zahl der Messwerte 
 
xi…….Meßwert 

x …….arithmetisches Mittel der Meßwerte  x
x

n

n
1

1

 

 

s…….Standardabweichung   s

x x

n

i

n

1

2

1
 

f…….Zahl der Freiheitsgrade = n-1 
 
P…….statistische Sicherheit (laut Konvention meist P = 0,95) 
 
t(P,f)…….Student Faktor, für zweiseitige Fragestellung, mit statistischer Sicherheit P  
und f Freiheitsgrade 
 
 
Kommentar 
 

1. Die Angabe eines Analysenresultates ist ohne die Angabe seines 
Unsicherheitsbereichs unvollständig, da die Qualität des Analysenresultats 
nicht ersichtlich ist. Es müssen daher mindestens noch n und s angeführt 
werden. 

 

2. Der Unsicherheitsbereich wird – in Abwesenheit systematischer Fehler – 
durch den Vertrauensbereich beschrieben. Dieser gibt das Intervall an, 
innerhalb dessen sich der wahre Wert mit einer bestimmten 
Wahrscheinlichkeit befindet. Je größer der Vertrauensbereich, desto größer ist 
das Ausmaß der Unsicherheit. 

 

3. Auch die Formel für den Vertrauensbereich zeigt, dass ein Einzelwert zu 
wenig ist: er kann ein Ausreißer sei. Sie zeigt aber auch, dass es nicht viel 
bringt, aus einer Probe mehr als 4-5 Parallelbestimmungen zu machen, da der 

Vertrauensbereich nur mit 1/ n  und daher nur mehr langsam kleiner wird. 
 

4. Die Zahl der unsicheren Stellen, die in experimentellen  Meßresultaten 
angegeben wird, ist meist limitiert auf eine Stelle oder, wenn die 
experimentelle Unsicherheit sehr klein ist, auf zwei unsichere Stellen. Die 
Position der unsicheren Stellen im Analysenergebnis wird durch die 
Standardabweichung bestimmt. Die erste unsichere Stelle ist jene, bei der die 
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erste Zahl ungleich Null ist. Prinzipiell  sollten nie mehr als zwei unsichere 
Stellen im Analysenergebnis angegeben werden. 

 
Tabelle: Beispiele für richtige und unrichtige Angaben des Analysenresultats (X ± s) 

Richtig  

 

Akzeptabel bei hoher  

Genauigkeit     

Falsch 

24,2 + 0,3 24,23 + 0,36 24,236 + 0,362 

4,8 + 0,1 4,83 + 0,19 4,836  + 0,19 
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Statistische Tabellen 
 
 

Zweiseitige Student t-Verteilung 
 
 

f P = 95 % P = 99 % 

1 12,706 63,657 

2 4,303 9,925 

3 3,182 5,841 

4 2,776 4,604 

5 2,571 4,032 

6 2,447 3,707 

7 2,365 3,499 

8 2,306 3,355 

9 2,262 3,250 

10 2,228 3,169 

11 2,201 3,106 

12 2,179 3,055 

13 2,160 3,016 

14 2,145 2,977 

15 2,131 2,947 

16 2,120 2,921 

17 2,110 2,898 

18 2,101 2,878 

19 2,093 2,861 

20 2,086 2,845 

25 2,060 2,787 

30 2,042 2,750 

∞ 1,960 2,576 
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Pipettieranleitung 
 

In Abhängigkeit von der zu pipettierenden Lösung  sind 2 Arten von  Pipettiertechniken 

möglich. 

 

1) Vorwärts pipettieren für wässrige Lösungen, Puffer, verdünnte Salzlösungen, 

verdünnte Säuren und Laugen 

 

 

 

2) Reverses pipettieren  für viskose Lösungen, Lösungen mit hohem Dampfdruck und 

stark benetzende Lösungsmittel 
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Unabhängig von der jeweiligen Dosiertechnik sollten während des Pipettierens folgende 

Punkte beachtet werden: 

 Bei Luftpolsterpipetten sollte die Pipettenspitze so gewählt werden, dass das  Luftpolster 

zwischen dem Pipettierkolben und der Flüssigkeitsoberfläche möglichst klein ist. Die 

Pipettenspitze sollte dem Dosiervolumen angepasst sein. Je kleiner die Spitze ist, desto 

kleiner ist das Luftvolumen  und desto höher ist die Richtigkeit der Ergebnisse. 

 Zum Ansaugen der Flüssigkeit sollte die Spitze nur wenige Millimeter in das Medium 

eintauchen. 

 

Volumen 
[µL] 

Optimale Eintauchtiefe 
[mm] 

0,1 -1 1 

1 -100 2-3 

101 -1000 2-4 

1001 -10000 3-6 

 

 

 Das zwei- bis dreimalige vorbenetzen (Füllen und Entleeren) der Spitze verbessert die 

Richtigkeit und Präzision der Ergebnisse. Bei Volumen bis 20 µl sollte die Pipettenspitze 

unbedingt vorbenetzt werden. 

 Die Flüssigkeitsaufnahme sollte langsam und gleichmäßig erfolgen. 

 Eine Wartezeit von 1 bis 3 s für das Aufsteigen der Flüssigkeit in die Spitze sollte 

berücksichtigt werden. 

 Die gefüllte Spitze sollte an der Gefäßwand abgestreift werden, um Flüssigkeitsreste an der 

Außenfläche der Spitze zu vermeiden. 

 Die Pipette sollte während des Ansaugens senkrecht gehalten werden. Mit zunehmendem 

Neigungswinkel der Pipette beim Aufziehen der Flüssigkeit sinkt der hydrostatische Druck in 

der Spitze  und es wird ein größeres Volumen angesaugt. 

 

Tabelle: Einfluß der Eintauchtiefe und des Haltewinkels einer 100 µL  Pipette während der 

Flüssigkeitsaufnahme 

Position der Pipette Systematische 
Meßabweichung 

Pipette vertikal 
Eintauchtiefe  ca. 1 cm 

0,2 – 0,4 % 

Pipette vertikal 
Eintauchtiefe ca. 3 cm 

0,6 – 0,8 % 

Haltewinkel 30  bis 40° 
Eintauchtiefe ca. 2 bis 4 cm 

1,0 – 1,2 % 

 

 

 

 


